Companion documentation to

*Working smarter, not harder, with the KPS Indexing Plugins*

by Lucie Haskins

(article originally published in The Indexer Vol. 31 No. 4 December 2013)
PDF of original article available on [http://luciehaskins.com](http://luciehaskins.com) (resources page)

Version 2.0 (updated 10/27/14)
This companion piece to my The Indexer article *Working smarter, not harder, with the KPS Indexing Plugins*) contains instructions on how to use the KPS index-related utilities.

It has been assembled in an effort to bring together (in one place) the information that is scattered throughout the extensive KPS website.

Many thanks to Rich Bines (Kerntiff Publishing Systems developer) for the documentation he has uploaded under each individual utility and to Jill Edwards for her extensive step-by-step writeup for the Index Editor utility.

Please direct usage questions to:
Rich Bines at editmarks@btinternet.com (twitter: @KerntiffPublish)

Feel free to visit the KPS website at http://www.kerntiff.co.uk.

**DIS:** dedicated indexing software (CINDEX, MACREX, SKY Index)
## TABLE OF CONTENTS

### INDEX UTILITIES PLUGIN SUITE

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Installation</td>
<td>5</td>
</tr>
<tr>
<td>Table of Indexing-Related Plugins</td>
<td>6</td>
</tr>
<tr>
<td>Preferences</td>
<td>7</td>
</tr>
<tr>
<td>Keyboard Shortcuts</td>
<td>8</td>
</tr>
<tr>
<td>Limitations / Known Bugs</td>
<td>8</td>
</tr>
</tbody>
</table>

### CREATING INDEX ENTRIES

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Quick Index and Quick Index Search</td>
<td>9</td>
</tr>
<tr>
<td>Quick Index Search Palette</td>
<td>10</td>
</tr>
</tbody>
</table>

### IMPORTING EXISTING INDEXES

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 1: Index Import</td>
<td>11</td>
</tr>
<tr>
<td>Installation</td>
<td>11</td>
</tr>
<tr>
<td>A. Preparing the DIS index file for use with Index Import</td>
<td>12</td>
</tr>
<tr>
<td>B. Adding your RTF index file to InDesign</td>
<td>13</td>
</tr>
<tr>
<td>C. Import process</td>
<td>14</td>
</tr>
<tr>
<td>Step 2: Marker Mover</td>
<td>15</td>
</tr>
<tr>
<td>Step 3: Remove Temp Import Boxes</td>
<td>15</td>
</tr>
</tbody>
</table>

### EDITING INDEX ENTRIES

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Index Editor</td>
<td>16</td>
</tr>
<tr>
<td>Limitations</td>
<td>16</td>
</tr>
<tr>
<td>Background</td>
<td>17</td>
</tr>
<tr>
<td>Installation</td>
<td>17</td>
</tr>
<tr>
<td>Using Index Editor</td>
<td>17</td>
</tr>
<tr>
<td>Correcting spelling or changing the text in main or subheadings</td>
<td>18</td>
</tr>
<tr>
<td>Changing subentries</td>
<td>20</td>
</tr>
<tr>
<td>Changing or adding page ranges</td>
<td>21</td>
</tr>
<tr>
<td>Flipping entries</td>
<td>22</td>
</tr>
<tr>
<td>Adding subentries to existing main headings</td>
<td>24</td>
</tr>
<tr>
<td>Adding new entries (embedding new index markers)</td>
<td>25</td>
</tr>
<tr>
<td>Deleting entries</td>
<td>26</td>
</tr>
<tr>
<td>After editing is completed</td>
<td>27</td>
</tr>
<tr>
<td>Index Ref Remover</td>
<td>28</td>
</tr>
<tr>
<td>Orphaned Marker Remover</td>
<td>28</td>
</tr>
<tr>
<td>Orphan Killer / Orphan Merger Utilities</td>
<td>29</td>
</tr>
<tr>
<td>Page Ranger</td>
<td>30</td>
</tr>
</tbody>
</table>
NAVIGATING, SEARCHING, OR VIEWING INDEX ENTRIES .......................31

INDEX NAVIGATOR ...........................................................................................................31

  Limitations .....................................................................................................................31

QUICK INDEX SEARCH .....................................................................................................31

INDEX EDITOR ......................................................................................................................32

INDEX TOOLTIP PLUGIN .....................................................................................................32

  Installation .....................................................................................................................32
  Preferences .....................................................................................................................32
  Usage tips .......................................................................................................................32
  Limitations .....................................................................................................................32

PDFINDEXSTICKIES .........................................................................................................33

  Installation .....................................................................................................................33
  Preferences .....................................................................................................................33
  Using PDFInDexStickies ...............................................................................................33

INDEX 2 BOOKMARKS .......................................................................................................34

EXPORTING OR HYPERLINKING INDEXES .................................................................35

HYPERLINKER ...................................................................................................................35

  Limitations .....................................................................................................................35

EXPORT INDEX ..................................................................................................................36
Index Utilities plugin suite

Index Utilities is a collection of scripts and plugins that help embed index markers in InDesign. Index Utilities is available for Mac / Win InDesign CS 5, 5.5, 6, and CC.

Why would I want to use Index Utilities?

- If you want to create your index in an external indexing system and have it embedded into InDesign.
- Need the extra features an external indexing system and need to get the index into InDesign.
- Need the extra sorting capabilities of an external indexing system and need it reproduced in InDesign.
- You receive the index from a third party and need it in InDesign double quick.
- Would like to export your index to ePUB.
- Want your index fully hyperlinked.

The plugins have used larger fonts for the user interface, KPS has thought about indexers’ eyes!

Most buttons can have keyboard shortcuts, which should speed things up. If one doesn’t, KPS will add it. Just contact them with your request.

Installation

Index Utilities is supplied as a zipped package.

Macintosh
Unzip the supplied package and copy the IndexUtilities folder to your InDesign plugins folder and restart InDesign.

Windows
Extract all from the zipped package and copy the IndexUtilities folder to your InDesign plugins folder and restart InDesign.

The plugins folder is typically found in C:\Program files \ Adobe \ Adobe InDesign \ Plugins.
<table>
<thead>
<tr>
<th>Table of Indexing-related Plugins</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Creating index entries</strong></td>
</tr>
<tr>
<td><strong>Quick Index</strong> and</td>
</tr>
<tr>
<td><strong>Quick Index Search</strong></td>
</tr>
<tr>
<td><strong>Importing existing indexes</strong></td>
</tr>
<tr>
<td><strong>Index Import</strong></td>
</tr>
<tr>
<td><strong>Marker Mover</strong></td>
</tr>
<tr>
<td><strong>Remove Temp Import Boxes</strong></td>
</tr>
<tr>
<td><strong>Editing index entries</strong></td>
</tr>
<tr>
<td><strong>Index Editor</strong></td>
</tr>
<tr>
<td><strong>Index Ref Remover</strong></td>
</tr>
<tr>
<td><strong>Orphaned Marker Remover</strong></td>
</tr>
<tr>
<td><strong>Orphan Killer</strong></td>
</tr>
<tr>
<td><strong>Orphan Merger</strong></td>
</tr>
<tr>
<td><strong>Page Ranger</strong></td>
</tr>
<tr>
<td><strong>Navigating, searching, or viewing index entries</strong></td>
</tr>
<tr>
<td><strong>Index Navigator</strong></td>
</tr>
<tr>
<td><strong>Index ToolTip</strong></td>
</tr>
<tr>
<td><strong>PDF InDex Stickies</strong></td>
</tr>
<tr>
<td><strong>Index 2 Bookmarks</strong></td>
</tr>
<tr>
<td><strong>Quick Index Search</strong></td>
</tr>
<tr>
<td><strong>Index Editor</strong></td>
</tr>
<tr>
<td><strong>Exporting or hyperlinking indexes</strong></td>
</tr>
<tr>
<td><strong>HyperLinker</strong></td>
</tr>
<tr>
<td><strong>Export Index</strong></td>
</tr>
</tbody>
</table>

*Part of the Index Utilities suite of plugins. ** Part of the Extra Tools suite of plugins
Preferences

Index Utilities has some customizable preferences. The preferences (see below) set the column widths in the Utilities palettes and Highlight is used to help show the active field.

Set the column widths for the palettes and the color of the active field in a palette.

A 4.5-minute video demoing Index Import and HyperLinker can be accessed from http://www.kerntiff.co.uk/products-4-indesign/indexutilities. The index was created by Mary Harper in SKY. The book demoed in the video is "dragon-ball-z-its-over-9000" by Derek Padula.
Keyboard Shortcuts

To set up keyboard shortcuts for Index Utilities it’s best to create a new keyboard set.

1. Make sure you do not have any documents open.
2. From the Edit menu select Keyboard Shortcuts...
3. Create a new Keyboard set, “MyIndexing.” (Use the New Set... button to create a new set.)
4. Select Other from the Product Area list.
5. Select Marker Mover... from the list.
6. Click into the New Shortcut field.
7. Press the keyboard sequence that you want to use to open the Marker Mover palette. If the sequence is available for use, you will see [unassigned] under the New Shortcut field.
8. Press the Assign button.
9. Press the OK button.

Limitations / known bugs

The plugins / scripts are not well suited to indexes greater than 1000 index entries. The software becomes slow.
Creating Index Entries

Quick Index and Quick Index Search

Quick Index is a convenient way to add index markers in InDesign. The floating palette (see below) is automatically populated from the current selection.

Use the Flip button to switch Main with Sub 1. The Sort By fields apply special sorting to the index. Pg Rg: sets the page range for the index. Add saves the current record and leaves existing entries in fields, ready for next record. Use the Topics menu to select the main index heading from the document / book index. Command keys can be set for the Add and Flip buttons.

The Search field in Quick Index Search searches the content of the text, not the index entries. (However, both Index Editor and Index Navigator search index entries.)

Quick Index Search works with the Character / Paragraph style popups to form a logical AND. Check Whole Words to constrain the search to an exact phrase. List... uses a list of terms to search from. Clear the Search field to search for any text marked with a style sheet. Set the Character popup to [None] to search for text.
Quick Index Search Palette

1. A clickable list showing the found string. Alt- click the list to exclude the found string from the index.
2. The **Paragraph** style to search for.
3. The **Character** style to search for.
4. The string to search for.
5. The **Search** button.
6. Search for **Whole Words** only.
7. Search using **List** of terms.
8. Add all the found items in the list to the index.
9. The **Main** entry for the index record. To exclude from search, place an asterisk (*) at start of this field.
10. A popup menu showing all current topics for main entries. Populates **Main** entry. Use with the **Search** button to find matching locations in the document.
11. Special **Sort By** criteria added to the InDesign **Main** entry.
12. The **Page Range** for this index record.
13. The **Sub 1** entry for this index record.
14. Special **Sort By** criteria for the **Sub 1** entry.
15. Add this index record to the InDesign document at the current selection point.
16. Flip the **Sub 1** entry with the **Main** entry.
17. When checked, clicking into the list will cause the plugin to bring the selection into view.
18. Clicking this question mark will take you to the KPS website.
19. Reveals two additional **Sub** fields, only available in the full InDesign plugin.
Importing Existing Indexes

Importing DIS indexes is a three-step process (detailed below), using three utilities in the following order:

1. **Index Import**
2. **Marker Mover**
3. **Remove Temp Import Boxes**

**Step 1: Index Import**

The **Index Import** plugin allows the user to add index markers to an InDesign document or book based on an index created in dedicated indexing software (DIS) (CINDEX, MACREX, or SKY Index). **Index Import** allows you to add into InDesign the index entries you created and edited in DIS and to provide a tagged InDesign file to publishers who want to be able to update the text and regenerate the index.

After the index has been created and edited using your DIS, a properly formatted RTF file is placed into a new InDesign document. This file will be the basis for embedding index markers in the InDesign document / book file(s).

The embedded markers can be moved to the correct page location with **Marker Mover**.

If the pagination of the document changes and you have NOT moved the markers with **Marker Mover**, the index will need to be re-imported.

When the generated index is exported to interactive PDF, the links are maintained.

A 4.5-minute video demoing **Index Import** and **HyperLinker** can be accessed from http://www.kerntiff.co.uk/products-4-indesign/indexutilities. The index was created by Mary Harper using SKY Index. The book demoed in the video is "dragon-ball-z-its-over-9000" by Derek Padula.

**Installation**

Unzip the **IndexUtilities.zip file.** Copy the IndexUtilities folder to the InDesign Plugins folder:

*Windows XP, Vista, and Windows:*  C:\Program Files\Adobe\Adobe InDesign\Plugins

*Mac OS:*  Applications/InDesign/Plug-Ins
A. Preparing the DIS index file for use with Index Import

1. When you have finished creating and editing your DIS index, make a backup copy of your index.
2. Put your index in page number order (PNO) and remove/delete all the cross references.
3. Change the formatting of your index so that
   a. each main and subentry has two spaces and no comma between the main or subentry text and the first locator, and
   b. the index is in one column and uses tabs for indentation.

   This is because Index Import expects to find the page numbers at the end of the index entry. If your index contains headings that end with a number, for instance:

   Return of the Klingons, Episode 13, 10-12

   There are several things we can do.
   a) change the entry, to: Episode 13, Return of the Klingons, 10-12.
   b) insert a double space after Episode 13, <space><space>. The double space will be removed by the import routines.

   The import routines know about page ranges; you may use a hyphen, or an em dash.
   The Index Import plugin uses tabs at the beginning of the index entry to determine the entries level, main, sub1, sub2.

4. Generate/create the RTF file of your index. The figure below shows the proper index formatting.
B. Adding your RTF index file to InDesign

1. In InDesign, open the document/book for which your index was created. Create a new blank document for the index file, save it with an appropriate filename, and add the document to your book file.

2. With the new blank document open, use the InDesign Place command (File → Place). In the dialog box that opens (see below), select the RTF index file, and click Open.

3. The InDesign cursor is now loaded with your index text.
   a. Place the loaded cursor in the top left corner of your blank InDesign document.
   b. Press the Shift key and click once.
   c. The index text is placed into the InDesign document and the number of pages needed to accommodate the index are automatically created.
C. Import process

1. In the index document, select (highlight) as much of the index as you want to work with at one time (for example, choose one alpha letter group or the entire index).

2. Select **Index Import** from the **Index Utilities** menu. You may choose to display the entries in either alphabetical or page number order.

3. A dialog box (see below) opens.

   ![Index Import dialog box]

4. Use the **Index Import** dialog box to check your index entries and to make any changes that might be needed. Add any special **Sort By** (strings) that might be needed.

5. Close any InDesign documents not connected to this index. This is important! **Index Import** works on page numbers. Unwanted documents will be included in the page number calculations and may affect where index markers are placed. To speed the import, close the InDesign **Index Panel**.

6. Open the book or document you want to create an index for. In the case of a book, you should open all the documents in the book.

7. Once you are happy with the index, press the **Build Index** button.

You will see the fields in the dialog box update with your index entries as the index is being built. Once the index is built you will see an alert stating the number of index entries created.

You now have an InDesign document with your index embedded at the page level.
Step 2: Marker Mover

At this point in the import process, the imported markers reside in temporary frames at the top of each relevant page. You will need to manually move each index marker to its correct position within each page.

1. From the Index Utilities menu, select Marker Mover.
2. Scroll to a page where you expect to find some index entries. The Marker Mover palette will update automatically.
   a. Highlight the index entry in the Marker Mover palette
   b. Next, position the cursor by clicking where you want to embed your index entry on the page.
   c. Click Move.
      It is helpful if you have Hidden Characters showing (Alt+Ctrl+I), so you can see the marker being inserted.
      If the Only New Markers check box is checked, the Move Marker palette will contain only index entries that have not yet been moved (positioned on the pages).
3. Once finished, you have a truly embedded index. The index will update as the pagination changes.

Step 3: Remove Temp Import Boxes

Once all the index markers have been positioned, use Remove Temp Import Boxes (under the Extra Tools menu) to remove the temporary boxes created by the import process.

There is no dialog box associated with Remove Temp Import Boxes. Simply select it to invoke the process.

A completion message pops up when it has finished.

Even though the empty temporary text frames (see upper left corner of figure above) do not interfere with or distort any content in the INDD files, clients might be confused by them so they should be removed as a courtesy.
Editing Index Entries

Editing index entries is an important aspect of any indexing process, and KPS provides a robust solution for editing index entries with the sophisticated **Index Editor** as well as several **Extra Tools** plugins that perform single, specialized functions.

**Index Editor**

**Index Editor** helps create and edit embedded index entries in InDesign.

1. Use the **Flip Dn** button to flip entries down one level.
2. Use the **Flip Up** button to flip entries up one level.
3. When the **Jump to index on single click** check box is selected, **Index Editor** will try to bring the index marker into view by finding the document and page the marker is located on.
4. The **Update** button is used to update the currently selected index entry in **Index Editor**. Hold the Alt key down and the index marker is also moved to the current selection point in the document.
5. **Add** adds a new index entry. [Alt-add deletes the current index entry.]
6. Use the **Search** button to quickly find entries in the palette. If the **Jump to index on a single click** check box is checked this causes the index entry to come into view within the document.

**Limitations**

Index propagation only works in the current document.
Jill Edwards also wrote a multi-page manual for **Index Editor** in its early stages of development. While the screenshots are a bit dated (note the different bottom lines), the instructions are still extremely valuable and the manual has been copied in its entirety here:

**Background**

The **Index Editor** plugin allows the user to edit an InDesign index — that is, an index generated from the index markers embedded in an InDesign document or book. The **Index Editor** plug-in allows the user to:

- correct spelling in entries
- change the wording in main or subentries and propagate the changes to all identical entries
- change or add a page range
- flip the text in the main and subentry fields to create a new entry
- add a subentry to a main entry
- add new entries
- delete existing entries

Note that the changes made to the embedded index markers using **Index Editor** are reflected immediately in the InDesign **Index Panel**.

**Installation**

Unzip the **IndexUtilities.zip file**. Copy the IndexUtilities folder to the InDesign Plugins folder:

*Windows XP, Vista, and Windows 7:* `C:\Program Files\Adobe\Adobe InDesign\Plugins`

*Mac OS:* `Applications/InDesign/Plug-Ins`

**Using Index Editor**

Open your InDesign document or book. **Index Editor** reads the embedded index markers in these files. Click on the **Index Utilities** menu and choose the **Index Editor**. You have the option of displaying the index entries in alphabetical or page number order. See Figure 1 below.
The **Index Editor** window opens (Figure 2). The InDesign **Index Panel** is shown here for reference.

![Index Editor](image)

Figure 2

To edit entries, double click on the entry you wish to edit (unless you have checked the **Jump to index on single click** check box).

**Correcting spelling or changing the text in main or subheadings**

In the example below, the word “plants” is misspelled “palnts.” A snippet of the index generated by InDesign is displayed on the right. (Figure 3.)

![Index Editor](image)

Figure 3
After double clicking the “aquatic plants” entry, click in the **Main** field in the bottom half of the **Index Editor** window and correct the text, then click the **Update** button (Figure 4). The “palnts” text is corrected to “plants” and the change is propagated to all the identical main entries containing the misspelled word (Figure 5).
**Changing subentries**

*Index Editor* works the same in the subentry field. In the example below, “excessive growth of” (Figure 6) is changed to “nuisance levels of” (Figure 7). Once the change has been typed in, clicking the *Update* button will change all the sub headings containing “excessive growth of” to “nuisance levels of” (Figure 8).
**Changing or adding page ranges**

**Index Editor** allows the user to change or add a page range. (Entering a number in the **Page Range** field works the same way the Page Range feature works when first embedding index entries into InDesign—the page count includes the first page.) For example, to indicate a page range of 12-15, “4” is entered into the page range field.

In this example, the entry has a single page number for the locator. To change the locator to a range, double click the entry in the list at the top of the dialog box and then type the new number of pages into the page range field, in this example “2” (Figures 9 and 10). Click **Update**.

---

![Figure 9](image1.png)

![Figure 10](image2.png)
**Flipping entries**

Flipping the text between two fields can be done in **Index Editor**. The text in the fields may still need to be edited depending on the how the entries are worded.

In the example below, a new entry will be added by flipping “aquatic plants” and “lake ecosystems.” Select the text in one of the fields (the subheading field is selected in Figure 11; blue text indicates the “active” field) and click **Flip Up** because the subheading field is selected. If the main heading field is selected, the **Flip Dn** button would be used.

![Figure 11](image)

The text in this example needs editing (Figure 12).

![Figure 12](image)
After editing the text, click the **Add** button (Figure 13).

![Figure 13](image)

A new entry appears in the index entries list (Figure 14).

![Figure 14](image)
**Adding subentries to existing main headings**

In the same example below (Figure 15), “lake ecosystems” has two index entries, one of which has a subheading.

![Figure 15](image)

To add a subheading to the entry that currently has only a locator, double click the “lake ecosystems” entry with the page 3 locator. Type the subheading text into the **Sub 1** field and click the **Update** button (Figure 16).

![Figure 16](image)
**Adding new entries (embedding new index markers)**

In the example below, a new index marker for “animal habitats” will be inserted (Figure 17). (There is already another “animal habitats” entry on page 1.) Place your cursor in the InDesign document where you wish the marker to be added (red circle).

Type in the new main heading text (blue circle)—and a subheading and page range number if desired. Click the *Add* button. The new entry appears at the end of the **Index Editor** list and in the **Index Panel** (Figure 18).

A new index marker is embedded into the document.
Deleting entries
Deleting an entry can be done using the InDesign **Index Panel**. Click the triangles until the entry’s page locator is showing. Click on the locator and then click on the **Trash Can icon** at the bottom of the **Index Panel**.

![Index Panel](image)

Figure 19

[NOTE: **Index Editor** functionality has recently been enhanced to allow entry deletion as Figure 20 shows below. If you mouse over the **Add** button, you discover that it also acts as an **Delete** when the Alt key is pressed in conjunction with the **Add** button.]

![Index Editor V1.0.2](image)

Figure 20

However, demographics can help you spot certain trends that might shape values, attitudes, or feelings. Inner-city African American...
After editing is completed

After editing is completed, a revised index may be generated using the **Generate Index icon** in the InDesign **Index Panel**. Figure 21 shows a portion of the index used in these examples before and after editing.

![Index before and after editing](image-url)

Figure 21
Index Ref Remover

Index Ref Remover can be executed from the Extra Tools menu. It clears files of all existing embedded index markers, leaving the files completely free of index entries. Use this plugin with care! There is no undo!

This is extremely handy when INDD files contain embedded index markers from client testing or previous editions that were not completely cleaned out.

Index Ref Remover does not remove cross-reference markers since InDesign handles these types of index entries differently. (Cross-references are easily removed manually via InDesign’s Index Panel.)

Just click Index Ref Remover on ... and it completes. There are no windows associated with this plugin.

Orphaned Marker Remover

Orphaned Marker Remover (see below) is executed from the Extra Tools menu. Orphaned Marker Remover scans the selected index, comparing it against the InDesign embedded index markers and displays a list containing the markers that are not present in the index. You have the option to remove the orphaned index markers. (Orphaned in this plugin indicates an index marker that does not also exist as an entry in the generated index.)

Orphan markers only appear after index has been generated (created or updated with changes).

For example, if you deleted an index entry from the generated index itself, the InDesign embedded index marker would still exist as an index record. However, it would no longer have a pointer to it from the generated index.

This orphan record can easily be eliminated by deleting it via Index Editor or the native InDesign Index Panel.

Using Orphaned Marker Remover, you can delete entries from the index itself and then run Orphaned Marker Remover to ensure that the now orphaned markers are also permanently deleted.
Orphan Killer / Orphan Merger utilities
These two utilities remove orphan subentries, but in slightly different ways.

The figure below displays an entry (Gohan, Son) with an orphan subentry (afterlife spiritual training) showing.

<table>
<thead>
<tr>
<th>F</th>
</tr>
</thead>
<tbody>
<tr>
<td>▼ G</td>
</tr>
<tr>
<td>▼ Gohan, Son</td>
</tr>
<tr>
<td>▼ afterlife spiritual training</td>
</tr>
<tr>
<td>8</td>
</tr>
<tr>
<td>H</td>
</tr>
</tbody>
</table>

**Orphan Killer** *REMOVES* (deletes) the orphan subentry and now the page reference immediately follows the main heading. The subentry has been deleted (see figure below).

| ▼ G |
| ▼ Gohan, Son |
| 8 |
| H |

**Orphan Merger** also removes all orphans within the index but by keeps the subentry wording and *APPENDS (moves it up) to the main entry*, separated by a comma (see figure below).

<table>
<thead>
<tr>
<th>F</th>
</tr>
</thead>
<tbody>
<tr>
<td>▼ G</td>
</tr>
<tr>
<td>▼ Gohan, Son, afterlife spiritual training</td>
</tr>
<tr>
<td>8</td>
</tr>
<tr>
<td>H</td>
</tr>
</tbody>
</table>

Both **Orphan Killer** and **Orphan Merger** are invoked with one menu action and are completely undoable. There are no windows associated with these plugins.
Page Ranger

Page Ranger condenses (conflates) the page ranges in an InDesign index.

An example
==========
Aardvark, 1, 2, 3, 4
becomes:
Aardvark, 1-4

Another example
==========
Aardvark, 1, 2, 3, 4, 9, 21, 22, 23, 24
becomes:
Aardvark, 1-4, 9, 21-24

There are no windows associated with this plugin. Actions cannot be undone.
Navigating, Searching, or Viewing Index Entries

Index Navigator

Need to find your index markers? Open up Index Navigator and double-click an index entry displaying in the palette. Index Navigator will jump to the location where that index entry is embedded (similar to Go To Selected Marker in the Index Panel). You can perform simple search operations using the Search button and the field to the left of it.

Click Update to refresh the static display.

Below, page number is in the first column and the index hierarchy in the second column. The list can be ordered in the index order or page number order.

Notice the expanded window and larger font in the Index Navigator.

Limitations

Currently Search finds only the first occurrence of the term.

Quick Index Search

Quick Index Search (also discussed under Creating Index Entries) can be used for searching within index entries.
Index Editor

Index Editor (also discussed under Editing Index Entries) can be used for searching within index entries.

Index Tooltip plugin

Index Tooltip is completely independent of the Index Utilities suite of plugins and can be purchased separately from the KPS website.

Index Tooltip displays the contents of InDesign index marker(s) (in a tooltip bubble) when the mouse hovers over the index marker (blue caret). See figure below.

Installation

Index ToolTip is supplied as zipped archive.

Macintosh: Unzip the supplied package and copy the IndexToolTip folder to your InDesign plugins folder and restart InDesign.

Windows: Extract all from the zipped package and copy the IndexToolTip folder to your InDesign plugins folder and restart InDesign.

Preferences

The preferences are found under the Edit → Preferences → IndexToolTip menu.

The Show Index Tool Tip check box is used to activate or deactivate the plugin.

Search Ahead identifies the number of characters the plugin should look to the right of the blue caret. Use a number greater than one if you place index markers at the same insertion point.

Usage tips

1. Activate the plugin through the preferences.
2. Click into the page where the index markers are located.
3. Select the text tool.
4. Hover the mouse over the middle of the character next to the index marker.

The plugin works best if the mouse pointer is positioned just after the blue caret and towards the middle of the character.

Limitations

As of late 2014, Index ToolTip is not yet operable in InDesign CC.
PDFInDexStickies

**PDFIndexStickies** is completely independent of the **Index Utilities** suite of plugins and exports the contents of index markers to interactive PDF.

The figure below shows index markers displayed in InDesign.

![Index markers displayed in InDesign](image)

Below, the **Index ToolTip** plugin shows the content of the InDesign index markers.

![Index ToolTip showing index content](image)

Below, a PDF created using the **PDFIndexStickies** plugin.

![PDF created using PDFIndexStickies plugin](image)

**Installation**

**PDFInDexStickies** is supplied as zipped archive.

*Macintosh:* Unzip the supplied package and copy the PDFInDexStickies folder to your InDesign plugins folder and restart InDesign.

*Windows:* Extract all from the zipped package and copy the PDFInDexStickies folder to your InDesign plugins folder and restart InDesign.

**Preferences**

Preferences are found under the **Edit → Preferences → PDFInDexStickies** menu. Use the check box to activate or de-activate the plugin.

![Preferences menu with check box](image)

**Using PDFInDexStickies**

1. Activate the plugin through the preferences.
2. Export your document to interactive PDF.
Index 2 Bookmarks

Index 2 Bookmarks is completely independent of the Index Utilities suite of plugins and is available free of charge from the KPS website. It creates bookmarks at the same location as the index markers. To view the bookmarks, simply export the document to interactive PDF.

The figure above shows the interactive PDF file split into three panels. The left panel displays the bookmarks created by Index 2 Bookmarks. The middle panel displays the PDF content with the index marker contents displayed in a PDF comment. The right panel shows the index marker displayed in the Comments List.
Exporting Or Hyperlinking Indexes

HyperLinker

HyperLinker creates hyperlinks to existing InDesign indexes in PDF and ePub formats. The plugin can work on single documents or books.

A 4.5-minute video demoing Index Import and HyperLinker can be accessed from http://www.kerntiff.co.uk/products-4-indesign/indexutilities. The index was created by Mary Harper in SKY. The book demoed in the video is "dragon-ball-z-its-over-9000" by Derek Padula.

Preparing an index for hyperlinking depends on how the index was created.

1. Using an index created in a dedicated indexing system.
   a. Open all the documents connected to the index.
   b. Place the index in the appropriate pages in your document.
   c. Use Index Import / Marker Mover to get the index embedded.
   d. Select the content of the text frames containing your placed index and launch HyperLinker.

2. Indexes generated natively in InDesign must first be disconnected from InDesign.
   You are probably aware that InDesign will mark the text frames that it creates for the index so that it can update them, also these text frames will not export to ePUB. (The easiest way to disconnect the indexes is to create the index in a temporary text frame and then copy and paste the index into the desired text frames and then run HH):
   a. Open all the documents connected to the index.
   b. Create the InDesign index in a temporary text frame and then copy it to the desired index pages.
   c. Select the content of the text frames containing the copied index and launch HH.

While HyperLinker is building the index you will see three progress bars. An alert will be displayed once your index has been hyperlinked.

Your index is now hyperlinked and will export to PDF or ePUB.

Download a demo script at https://docs.google.com/file/d/0Bzky2nJJe7lFOHRYRmg4akJOSWs/edit?pli=1 https://docs.google.com/file/d/0Bzky2nJJe7lFOHRYRmg4akJOSWs/edit?usp=sharing

Limitations:

The imported / placed index must have tabs indicating the heading levels or it must be properly styled.
Export Index

Export Index creates a tab-delimited file ready for importing into DIS such as CINDEX, MACREX, and SKY Index. Export Index is versatile, exporting one chapter or multiple chapters at a time.

Export Index TAB exports one chapter (focus on a chapter file) at a time. (Highlight all the text in the file before invoking Export Index TAB or Multi Index Export.) Multi Index Export exports all open chapters.

As with the import process, the export process does not bring across forced sorting instructions (InDesign’s Sort By) nor does it include cross-references. Special characters (such as non-standard hyphens and quotation marks) do not convert as expected into the DIS files so a translation table (see below) is provided for identifying these characters and providing the substitute character for Export Index to use.
(Above) **Index Navigator** displays small window of index entries embedded within document at time **Index Export** was invoked.

(Above) Portion of TXT file output from **Index Export** process that matches the **Index Navigator** view. Notice that Roman numerals are exported correctly.